
 

 

 

 

 

 

STRAIN AMPLIFIER 

SA-570ST 
 

ユーザーズマニュアル 
 

ご使用前にこのユーザーズマニュアルをよくお読み下さい。 

お読みになったあとは、いつでも見られるところに大切に保管して下さい。 

 

 

お断り 

本書の内容については将来予告なしに変更することがあります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    ティアック株式会社   2016 年 4月 D01087200H 



注 意 

この装置は、クラス A 技術情報処理装置です。この装置を家庭環境で使用

すると電磁妨害を引き起こすことがあります。この場合には使用者が適切な対

策を講ずるよう要求されることがあります。 

VCCI-A 

 

はじめに 

このたびは、SA-570ST ストレイン/DC アンプをお買い求めいただきまして、誠にありがとうございます。 

本機の優れた性能を充分に発揮させ、正しく安全にご使用いただくため、ご使用の前に本取扱説明書をお読みいただき、お使い

くださるようお願いいたします。 

 

本書に記載されております情報、諸データは、あくまで一例を示すものであり、これらに関します第三者の知的財産権、およびその

他の権利に対して、権利侵害がないことの保証を示すものではございません。従いまして、上記第三者の知的財産権の侵害の

責任、又は、これらの製品の使用により発生する責任につきましては、弊社はその責を負いかねますのでご了承ください。 
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安全にお使いいただくために 
 

 

この記号は注意（警告を含む）を促す内容があることを告げるものです。 

 

この記号は禁止の行為であることを告げるものです。 

図の中に具体的な禁止内容（左図の場合は分解禁止）が描かれています。 

 

この記号は行為を強制したり指示する内容を告げるものです。 

図の中に具体的な指示内容（左図の場合は電源プラグをコンセントから抜け）が描かれています。 

 

 警告  

この表示を無視して、誤った取扱いをすると、人が死亡または重傷を負う可能性が想定される内容を示しています。 

 

■ 異常が起きたら 

万一、煙が出ている、変なにおいや音がするなどの異常状態のまま使用すると、火災・感電の原因となります。すぐに本体の電源

スイッチを切り、電源プラグをコンセントから抜いて下さい。煙が出なくなるのを確認して当社サービス部門に修理をご依頼下さい 

 

■ カバーを開けない 

この機器のカバーは絶対に外さないで下さい。感電の原因となります。内部の点検・修理は当社サービス部門にご依頼下さい。

この機器を改造しないで下さい。火災・感電の原因となります。 

 

■ ケーブルを傷つけない 

ケーブルの上に重いものをのせたりしないで下さい。コードを傷つけたり、加工したり、無理に曲げたり、ねじったり、引っ張ったり、加

熱したりしないで下さい。 

火災・感電の原因となります。 

■ 仕様の電源電圧以外の電圧で使用しない 

仕様の電源電圧以外の電圧で使用しないで下さい。火災・感電の原因となります。 

 

■ 水にぬらさない 

この機器を水にぬらさないで下さい。内部に水が入ったまま使用すると、火災・感電の原因となります。内部に水が入った場合

は、まず本体の電源スイッチを切り、電源プラグをコンセントから抜いて当社サービス部門にご連絡下さい。 

 

 注意  

この表示を無視して、誤った取り扱いをすると、人が傷害を負う可能性が想定される内容および物的損害の発生が想定される

内容を示しています。 

 

■ 適さない設置場所 

次のような場所に置かないで下さい。火災、感電やけがの原因となることがあります。 

- 調理台や加湿器のそばなど油煙や湯気があたる場所              - 湿気やほこりの多い場所 

- ぐらついた台の上や傾いた所など不安定な場所                   - 直射日光があたる場所 

■ ぬれた手でプラグにさわらない 

感電の原因となることがあります。 

 

■ 長期間ご使用にならないときは 

長期間この機器をご使用にならないときは、電源コードをはずして保管して下さい。 
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保証規定 

 

ハードウェア 
 

 保証期間はお買い上げ日から 1 年間です。 

取扱説明書、本体貼付ラベルなどに従った正常な使用状態で、保証期間内に故障が発生した場合には、最寄りのティアック

株式会社（以下、当社といいます）営業所、またはサービス部門が無料修理いたします。 

 

 保証期間内に故障して無料修理を受ける場合は 

本製品の取扱店、最寄りの当社営業所、またはサービス部門にご依頼下さい。なお、離島および離島に準ずる遠隔地への出

張修理を行った場合には、出張に要する実費を申し受けます。 

データ、収録媒体、当社製以外の装置又は部品、機構、付加物、改造を事前に本製品から取り外して下さい。 

 

 つぎの場合には保証期間内でも有料修理となります。 

１） ご使用上の誤りおよび不当な修理や改造による故障および損傷 

２） お買い上げ後の輸送、移動、落下などによる故障および損傷 

３） 火災、地震、水害、落雷、その他の天災地変、公害や異常電圧による故障および損傷 

４） 接続している他の機器に起因する故障および損傷 

５） 異常摩耗、異常損傷を除き、自然消耗とみなされた消耗部品による故障および損傷 

６） 特殊業務または特に苛酷な条件下において使用された場合の故障および損傷 

７） 点検のためのメンテナンス 

 

 上記は、当社製品のハードウェア部に関する保証の全てを規定したものであり、法律上の瑕疵担保責任を含む全ての明

示又は黙示の保証責任に代わるものです。当社の保証責任は、本製品の修理又は交換に限られます。当社は、いかな

る場合にも、お客様の逸失利益及び第三者からお客様に対してなされた賠償請求に基づく損害については責任を負いか

ねます。 

 

 上記保証は、日本国内においてのみ有効です。 

 

 保証期間経過後の修理は 

本製品の取扱店、最寄りの当社営業所、またはサービス部門にお問い合わせ下さい。 

 

 保証内容に対するお客様の権利について 

この保証内容によって保証を発行している者（保証責任者）、およびそれ以外の事業者に対するお客様の法律上の権利を制

限するものではありません。 

 

 

ソフトウェア 
 

 保証期間は、お買い上げ日から 90 日間です。 

当社は、当社製品のソフトウェア（以下、本ソフトウェアといいます）が、取扱説明書に記載の環境を満たすコンピュータ上に正し

くインストールされていることを前提として、取扱説明書に記載の機能を履行することを保証します。本ソフトウェアが保証期間中

に所定の機能を履行しない場合、お客様は、ご購入店を通じて修正を要求することができます。万一修正不能な場合は、返

金手続きをとらせていただきます。なお、上記は、本ソフトウェアの操作が中断しないことや誤りのないことを保証するものではあり

ません。 

 

 派生的損害の免責: 当社は、本ソフトウェアの使用や使用不能から生じたいかなる損害（事業上の損失、営業の中断、

営業上の情報の損失、その他の金銭上の損害など）についても責任を負いません。たとえ、その損害の可能性が当社に事

前に知らされていたとしても同様です。 

 

 上記保証は、日本国内においてのみ有効です。 

 

 保証内容に対するお客様の権利について 

この保証内容によって保証を発行している者（保証責任者）、およびそれ以外の事業者に対するお客様の法律上の権利を制

限するものではありません。 
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ソフトウェア使用契約 
 

 ティアック株式会社（以下、当社といいます）の製品に付属するソフトウェア（以下、本ソフトウェアといいます、別途個別に使

用許諾契約が明示されるものを除きます。）は、お客様が以下のソフトウェア使用契約の条件に同意されることを前提とし

て、ご使用を許諾するものです。万一、同意頂けない場合は、パッケージ全てをご購入店へご返却下さい。購入代金を返

金させて頂きます。お客様が以下のソフトウェア使用契約の条件に違反されますと、当社の権利を侵害することになり、以

降のご使用の停止、また、損害賠償等の請求対象となりますことをご承知おき下さい。 

 

 本契約は、お客様が本ソフトウェアのインストールを開始したときから発効します。ご同意頂けない場合は、インストールをし

ないで下さい。既にインストール済みの場合は直ちにソフトウェアの実行を終了し、アンインストールして下さい。 

 

 当社は、本ソフトウェアを１台のコンピュータ上で<使用>する権利をお客様に許諾します。 

 

 お客様が本ソフトウェアを取得されたことは、本ソフトウェア契約に規定された以外に本ソフトウェアのいかなる権利、権原若

しくは利権の取得を意味するものではありません。お客様は、本ソフトウェアが当社に帰属する著作物として<万国著作権

条約>または<文学的および美術的著作物保護に関するベルヌ条約>の加盟国の著作権法に基づき保護されることをご

認識下さい。本ソフトウェアの著作権は当社に帰属しております。 

 

 お客様は、本ソフトウェアをバックアップ以外の用途で複製することはできません。 

お客様は、本ソフトウェアの解析をしたり、コンパイラ言語やアセンブラ言語に変換することはできません。 

お客様は、本ソフトウェアを当社の事前承諾無く、第三者に譲渡することはできません。 

 

 上記契約に関し、ご不明な点等ございましたら、下記宛にご連絡下さい。 

 

商標について 

 Microsoft、Windows Vista、および Windows は、米国 Microsoft Corporation の、米国およびその他の国における登録

商標または商標です。 

 

 Pentium は、アメリカ合衆国およびその他の国における Intel Corporation の商標です。 

 

 その他、記載されている会社名、製品名は各社の商標または登録商標です。 

 

 

Copyright © 2005 –2016 TEAC Corporation.  All rights reserved. 
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第 1章 概要 
 
 

1.1. 概要 

本機はひずみゲージ、及び半導体ゲージ各種トランスデユーサを入力とするDCブリッジ方式のアンプで、ストレインアンプとDCアンプに切り替え使用できる 

多機能アンプです。 

ブリッジ電源、オートバランス、較正電圧、ローパスフィルタ、ハイパスフィルタなど、ひずみ計測、DC電圧測定に必要な基本機能を装備し、最大5000倍の感

度とDC～150 kHzの広帯域周波数特性を持っています。 

 
 

1.2. 製品の特長 

 ・容易な感度設定 

センサの定格出力（ひずみ、mV など）と希望する出力電圧(Ｖ）を設定するだけで感度調整が完了します。TEDS 機能により TEDS センサの使用時に

は、より感度設定が容易に行えます。 

 

 ・広い計測レンジ、高い基本性能 

ストレインアンプとしては、100×10－６ひずみ入力で 0.5V 出力（ B.V：2V,ゲージ率：2.0）の感度があり、DC アンプとしては、最大±100mV まで入力でき

ます。 

また、常に信頼性の高い計測ができるよう温度安定度・同相成分除去比など、高い基本性能を持っています。 

 

 ・オートバランス及び出力オフセット機能を内蔵 

スイッチを押すだけでバランス調整可能な電子式オートバランス回路を内蔵しています。またバランス操作とは別にゼロバランス量をスイッチでキャンセルで

きますので、ゼロバランス量を除いた現在のひずみ量や電圧値を確認できます。また、オートバランス機能とは独立して、出力オフセット機能を内蔵してい

ますので、出荷電圧レベルまで（±10%ステップ）出力電圧のシフトが可能です。 

  

 ・ブリッジ電源を内蔵 

ひずみ増幅器、校正回路、ブリッジ電源などひずみ増幅器としての機能をすべて内蔵していますのでセンサを接続だけで測定が可能です。センサ以外の

測定には、ひずみゲージ用ブリッジボックスを使用することにより４ゲージ以外のゲージ接続法が可能です。 

 

 ・多彩な表示機能 

A/D コンバータを内蔵し、増幅後の出力電圧表示のほか入力ひずみ（電圧）量表示、ピーク値表示機能を備えています。 また、従来からのアナログ 

メータに替わる LEDバーグラフメータにより直感的に出力値を認識できます。 

 

 ・連動設定機能 

最大 8台のアンプを連結可能です。LINK接続すると 1台のアンプから LINKモード（連動）を設定したアンプの BALANCEや CAL±の操作や設定値

のコピーを行うことが可能です。 

（LINK 操作：BALANCE、CAL-、CAL+、設定コピー） 

 

 ・PC 接続 

付属のアプリケーションをインストールした PC と USB 接続することで、連結したアンプに対し各種設定、及び測定値のモニタ表示が行えます。 

 

 

1.3. 付属ソフトウェア 

SA-570ST にはソフトウェアが付属しています。 

 

付属ソフトウェア(CD にて供給) 

 SA-570 Navi プログラム：SA-570 Navi プログラムをインストールした PC を SA-570ST の USB に接続して使用します。 

 SA-570 Navi プログラムは、LINK 接続した 8 台までのアンプを制御することができます。 

 SA-570ST の各種 MENU 項目の設定内容の表示や変更及びモニタ表示を PCで行うことができます。 

  

 対応 OS  ：Windows Vista、Windows 7、Windows 8.1、Windows 10 

 

付属ソフトウェア SA-570 Navi の使い方は、５章と６章をお読み下さい。 

 

 

1.4. パッケージ内容 

SA-570ST には以下のものが同梱されています。万が一、不足しているものがありましたら、弊社までご連絡ください。 

 

品名 数量 

SA-570ST 本体 １ 

簡易取扱説明書 １ 

KULITE 圧力トランスデューサ用 簡易取扱取説書 1 

AC アダプタ １ 

CD-ROM （取扱説明書、SA-570 Navi プログラム） １ 

本体カバー用ねじ （スタンドを取り外した際に使用します） 4 
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第 2章 各部の名称 
 

2.1. フロントパネル 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

名称 説明 

① 単位インジケータ モニタ表示値の単位を示します。 

② モニタ表示 アンプの入力値/出力値とアラームを表示します。 

③ マイナスインジケータ モニタ表示値が負の値のときに点灯します。 

④ レベルメータ モニタ表示値のレベルをバーメータ表示します。 

⑤ DSP MODE （ディスプレイモード） モニタ表示の平均値（MEAN）とピーク値（PEAK）の切り替えスイッチです 

選択されている PEAK/MEAN のインジケータが点灯します。 

⑥ MONITOR （LINK） (モニタ/LINK) モニタ表示の入力値（IN）と出力値（OUT）の切り替えスイッチです。LINK 操作時は LINK キーとして使用します。 

選択されている IN/OUT のインジケータが点灯します。 

入力値（IN）は、出力値から換算して表示しますので、実際の入力値ではありません。 

⑦ 単位インジケータ 設定表示値の単位を示します。 

⑧ 設定表示 各 MENU 項目の設定値を表示します。 

⑨ ALARM アラームやエラーが発生したときに点滅または点灯します。 （4.5. アラームとエラーを参照） 

⑩ MENU とインジケータ SA-570ST の各種設定メニューとインジケータです。インジケータは MENU の選択、各項目の ON/OFF を示します。 

⑪ ST/DC インジケータ ストレインアンプモードと DC アンプモードを示します。 

⑫ BALANCE キー オートバランスを実行するスイッチです。 

⑬ FINE インジケータ OUT RANGE の FINE 調整とオートバランス実行時に点灯します。 

⑭ 左/右キー（－/＋） MENU 項目の設定時に入力桁の移動や微調整及び CAL の極性に使用するスイッチです。 

⑮ 上下キー MENU 項目や設定値の選択時に使用するスイッチです。 

⑯ OFF キー MENU 項目の各機能を無効にするスイッチです。 

⑰ ON キー MENU 項目の各機能を有効にするスイッチです。 

⑱ ENTER キー MENU 項目の設定値を変更、設定するスイッチです。 

⑲ STANDBY/ON キー SA-570ST の電源を ON/OFF するスイッチです。 

⑳ USB 端子 付属アプリケーションをインストールした PC を接続する USB 端子です。 

 
 

 注意 

MONITOR の入力値(IN)で表示される値は、出力値（OUT）からの換算値です。実際の入力値ではありませんので注意して下さい。 

① 

⑪ 

⑩ 

⑨ 

⑧ 

⑦ 

⑥ ⑤ 

③ 

④ 

② 

⑫ 
⑬ 
⑭ 

⑮ 

⑯ ⑰ 

⑱ 

⑲ ⑳ 
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2.2. リアパネル 

リアパネルには、信号の入出力用コネクタやコントロールコネクタ、および電源スイッチなどが配置されています。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

名称 説明 

① 入力コネクタ ひずみゲージ式及び DC ブリッジ方式のセンサなどを接続します。（ブリッジ電圧リモートセンス/TEDS 対応） 

② 出力コネクタ アンプ出力の BNC コネクタです。 

③ EXTERNAL CONTROL コネクタ 外部からの BALANCE、CAL－、CAL＋の制御信号の入力コネクタです。 

④ GND 端子 フレームグランド端子です。 

⑤ DC IN コネクタ 付属の AC アダプタを接続します。または、外部 DC 電源を接続することもできます。 

⑥ TERMINATOR スイッチ 複数台の SA-570ST を LINK 接続したときのターミネーションスイッチです。（両端のユニットは ON、間のユニットは OFF） 

 

各コネクタの詳細については、「第 3 章 設置時の接続と設定」を参照して下さい。 

 

① 

② 

③ 
④ 

⑤ 

⑥ 
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2.3. スタンド 

SA-570ST の底面には、転倒防止のスタンドが取り付けてあります。 

スタンドは、取り外すことができます。 

 

 

スタンドの取り外し手順 

1. 本体底面のスタンドとゴム足のねじ（A、B、C）を緩めて取り外します。 

2. 付属ねじでカバーを止めます。 

付属ねじ：サラねじ M3*8 4 ヶ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 注意 

取り外したスタンドやゴム足及びねじ（A、B、C）は、元に戻す際に必要になりますので大切に保管して下さい。 

 

スタンド/ゴム足 

付属ねじ 

付属ねじ 

カバー 

ねじ A ねじ B 

ねじ C 

カバー 
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MEMO: 
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第 3章 設置時の接続と設定 
 

3.1. 入力信号の接続 

センサ等からの入力信号やブリッジ電圧のリモートセンス信号及び TEDS 信号を接続します。本体リアパネルにある INPUT コネクタに接続します。 

 

1. 入力コネクタ: 本体側 PRC03-21A10-7F (7 ﾋﾟﾝ) 

ピン番号 信号 説明 

A +EXC ブリッジ電圧出力＋ 

B -SIG 入力信号－ 

C -EXC ブリッジ電圧出力－ 

D +SIG 入力信号＋ 

E SHIELD シグナルグランド 

F +SENSE / TEDS ブリッジ電圧リモートセンス＋ / TEDS 

G -SENSE / GND ブリッジ電圧リモートセンス－ / TEDS GND 

適合プラグ：多治見無線製 PRC03-12A10-7M10.5 
 
 

2. センサの接続のしかた 

SA-570ST は、ひずみ計測、DC 電圧測定用の測定器です。ひずみゲージ又は DC 電圧を直接 SA-570ST に接続することはお勧めしません。 

ブリッジボックス（BX-100）を別にお求め下さい。 

 

・ブリッジ回路の接続 

SA-570ST のブリッジ電圧は 1V、2V、5V、10V が選択でき、最大電流は 30mA までです。 

350Ωセンサの場合は１個となります。120Ωゲージの場合は 2V をお勧めします。 

ブリッジ電圧の設定は、ご使用センサの取扱説明書の許容印加電圧以下で電流値 30mA 以下となる電圧を選択して下さい。 

  

・ブリッジ電源のリモートセンス回路について。 

SA-570ST の入力コネクタは NDI 規格のコネクタを使用しております。 

センサとの接続には 6 芯のシールドケーブルを使用した 6 線方式と、4 芯シールドケーブルを使用した 4 線方式があります。 

ブリッジ電源のリモートセンスは温度変化によってケーブルの導体抵抗値変化によるブリッジ電圧の変化を補正する回路方式でセンサ（ゲージ）までの

ケーブルが長い場合には 6 線方式をお勧めします。 

リモートセンスを使用しない場合でもセンサ入力プラグ内で A-F、C-G 端子間を短絡する必要はありません。 

但し、リモートセンス機能と TEDS 機能の同時使用はできません。 

 

 

 注意 

SA-570STは、リモートセンス“ON”にて感度較正を行っておりますので4線方式の場合使用されているケーブル、長さによりひずみ値が小さく表示されますの

でご注意下さい。 

 

2-1. ストレインアンプモード（ひずみの測定） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A

F

B

G

D

C

E

A (+EXC)

F (+SENSE/TEDS)

G (-SENSE/GND)

B (-SIG)

E (SHIELD)

D (+SIG)

C (-EXC)

A

B

C

D

4 線方式、TEDS センサのブリッジ結線図 

A

B

F

G

C

E

F (+SENSE/TEDS)

A (+EXC)

D

C (-EXC)

G (-SENSE/GND)

B (-SIG)

D (+SIG)

E (SHIELD)

A

B

C

D

TEDS メモリ

SIG

GND 

入力コネクタ 

センサ 

入力コネクタ 

センサ 

6 線方式、4 線方式のブリッジ結線図 
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A

B

F

G

E

D

C

D (+SIG)

F (+SENSE/TEDS)

A (+EXC)

C (-EXC)

G (-SENSE/GND)

B (-SIG)

E (SHIELD)

-

+

 

2-1. DC アンプモード（直流電圧の測定） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 注意 

入力方式がブリッジタイプのセンサに対応しているため、特に 10mV以下、10KHz 以上の信号を扱う場合には測定信号までシールド線を使用するなどして 

ハム、ノイズが乗らない様な測定法上の工夫が必要です。 またローパスフィルタ、ハイパスフィルタを使用し、測定信号帯域に絞って測定する方法もハム、 

ノイズを減らす有効な方法です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

3. 初めてセンサを接続する場合や仕様の異なるセンサに交換する場合のセンサ接続手順 

初めてセンサを接続する場合や仕様の異なるセンサに交換する場合は、POWER OFF の状態でセンサを接続し ENTER キーを押しながら

[STANDBY/ON]を押し、起動するまで ENTER キーを押し続けて下さい。 

センサや外部機器の保護のため、ブリッジ電圧（EXC）無効、出力電圧レンジ（OUT RANGE）無効、リモートセンス無し（R.SENSE/TEDS）の状態で

起動します。これらの項目は、起動後にセンサの仕様に合わせて設定して下さい。 

尚、起動時は、ブリッジ電圧や出力電圧レンジが無効に設定されているなどの原因でアラームが発生します。 

 

上記以外の接続手順は、センサを外した状態で POWER ON し、センサの仕様に合わせて上記項目を設定後、POWER OFF してからセンサを接続し

ます。 

 
 

3.2. 出力信号の接続 

SA-570ST の出力を取り出します。本体リアパネルにある OUTPUT コネクタ（BNC）に接続します。 

 

出力コネクタ: 本体側 BNC 

BNC 説明 

BNC HOT 出力信号 

BNC GND 信号 GND 

 

出力電圧、電流は±10V、±10mA までです。また容量性負荷は 1000PF 以下でご使用下さい。 

 

 
 

-

+

-

+

A

G

B

F

E

C

A (+EXC)

D D (+SIG)

F (+SENSE/TEDS)

G (-SENSE/GND)

B (-SIG)

C (-EXC)

E (SHIELD)

入力コネクタ 

入力コネクタ 

信号が不平衡出力の場合 

信号が平衡出力の場合 
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3.3. 外部コントロール信号の接続 

外部からオートバランス、CAL+、CAL-の制御信号を入力します。本体リアパネルにある EXTERNAL CONTROL コネクタに接続します。 

 

1.  EXTERNAL CONTROL コネクタ: 本体側 D-SUB9 ﾋﾟﾝ （ｲﾝﾁねじ固定タイプ） 

ピン番号 機能 説明 

1 RESERVED 予約端子 （接続禁止） 

2 RESERVED 予約端子 （接続禁止） 

3 BALANCE オートバランス入力：COMMON とショートで ON （接点入力） 

4 CAL＋ CAL＋：COMMON とショートで ON （接点入力） 

5 CAL－ CAL－：COMMON とショートで ON （接点入力） 

6 MONITOR OUT モニタ出力信号 （出力インピーダンス：1.1ｋΩ） 

7 RESERVED 予約端子 （接続禁止） 

8 COMMON 内部 GND 

9 COMMON 内部 GND 

 

複数台(最大 8 台)の SA-570ST を連結し、LINK 接続している場合は、いずれか 1 台の SA-570ST に外部コントロール信号を入力して下さい。LINK 

モードを ONに設定した SA-570ST を制御することができます。 

 

 

 注意 

・SA-570ST 本体の制御を行うためには、該当のピンと COMMON を短絡します。その際、約 1mA の電流が流れますので注意して下さい。 

・RESERVRD 端子は内部で使用しますので何も接続しないで下さい。 

・MONITOR OUT 端子の出力インピーダンスは、1.1KΩです。 

 

2.  外部コントロール信号の入力等価回路 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.4. フレームグランドの接続 

フレームグランド（GND）の端子です。本体リアパネルにある GND 端子に接続します。 

 
GND 端子のビスをゆるめ、接地用のケーブルを接続します。 

 

←内部  外部→  

SA-570ST 

COM 

約 1mA 
 PUSH スイッチ 

開放 → ＯＦＦ 

短絡 → ＯＮ 

+3.3V 

COM 

 4.7KΩ 

 47μF 

 100Ω 

リレー接点 

IN が'H’の時 ON  

TTL オープンコレクタ 

トランジスタ 

IN 

トグルスイッチ 
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3.5. 電源の接続 

SA-570ST に電源を供給します。本体リアパネルにある DC IN コネクタに接続します。 

 

SA-570ST は、9V DC ～ 30V DC で動作します。SA-570ST への電源の供給方法は 2 種類あります。 

 

① 付属の AC アダプタを用いて、100V AC(50Hz/60Hz)の電源を 12V DC で供給する。 

② リアパネルの DC IN コネクタへ直接 DC 電源を供給する。 

 

本体側電源コネクタ:  

ピン番号 機能 説明 

1 +9 V ～ +30V ＋9V DC ～ +30V DC 電源入力 

2 RESERVED 予約端子 （接続禁止） 

3 RESERVED 予約端子 （接続禁止） 

4 GND 電源 GND 

適合プラグ：ヒロセ電機製 RM12BPE-4S(71) 
 
 

 注意 

・DC電源の動作保証電圧範囲は、9 V DC ～ 30 V DC となっています。それ以外の電圧範囲での使用は絶対に行わないで下さい。機器の破損、または

予期せぬシステムシャットダウンの可能性があります。 

・動作中に何らかの原因で動作が異常となり、その後電源が立ち上がらない場合は、一旦、電源供給ケーブルをすべて本体からはずし、再接続を行ってから

電源を入れて下さい。 

 

 

3.6. TREMINATORスイッチの設定 

SA-570ST は、複数台（最大 8 台）を連結して使用することが可能です。 

連結して LINK接続を行う場合は、個々の SA-570ST の TREMINATOR（終端抵抗）を設定しなければなりません。 

両端 2 台の SA-570ST は TREMINATOR ON に設定し、間の SA-570ST は TERMINATOR OFF に設定します。 

 

1 台でご使用の場合は、TREMINATOR ON で使用します。（出荷時設定） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 注意 

TERMINATOR スイッチを正しく設定しないと[Err.  3]の TERMINATOR エラーが発生したり、正常な動作ができない可能性があります。 

 

 

3.7. USBの接続 

SA-570ST は、付属のソフトウェア SA-570 Navi を使用することができます。 

SA-570ST フロントパネルの USB 端子（ミニ B コネクタ）に SA-570 Navi をインストールした PC を接続します。 

SA-570ST と PC は、市販の USB2.0 ケーブルで接続して下さい。 

 

付属ソフトウェア SA-570 Navi の使い方は、５章と６章をお読み下さい。 

 

 

 注意 

SA-570ST を複数台（最大８台）連結して LINK接続する場合、USB 接続できる PC は１台です。連結した SA-570ST のいずれか 1 台に接続して下さ

い。誤動作の原因になりますので複数台の PC を絶対に接続しないで下さい。 

また、1 台の PC に複数の USB ケーブルを用いて複数の SA-570ST を接続することは出来ません。 

ON OFF OFF ON 

最大 8 台 
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3.8. 連結 （LINK接続） 

SA-570ST は、最大 8 台までを連結し LINK 接続（連動）することができます。 

連結するためには、別売の連結用取付金具 TZ-SACPL が必要です。 

1 台を連結（増設）するために連結用取付金具 TZ-SACPL が 1 セット必要になります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 

 

 

 

連結時は、個々の SA-570ST に付属の AC アダプタを接続します。 

別売の｢連結対応の 8 台電源供給 AC アダプタ｣をお使いいただくと１つの AC アダプタで連結した全ての SA-570ST に電源を供給することができます。 

 

 

 注意 

・取り外したカバーA と B 及びサラねじは、元に戻す際に必要になりますので大切に保管して下さい。 

・個々の SA-570ST の TERMINATOR スイッチ、アンプ ID、LINK モードを正しく設定して下さい。 

 

別売の取付金具 TZ-SACPL の部品を使用します。 

 a. 連結板（上） （50 * 15） 2 ヶ 

 b. ねじ  (上部用 M3 * 8) 4 ヶ 

 c. 連結板（下） (50 * 81) 1 ヶ 

 

SA-570ST の連結手順 

 
①-1. 本体（SA-570ST）の脇に、連結する別ユニット（SA-570ST）を並べ、底面を上にして

配置します。（ユニットの連結は、右側または左側どちらへも連結可能です。） 

2. 隣接するカバーA と B の 2 枚を取り外します。（取り外したねじは②-2 で使います。） 

②-1. 中に見えるフラットケーブルを引き出し、連結するユニットに接続します。 

（フラットケーブルは、カバーC で押さえられていますので、カバーC のねじを少しゆるめると 

引き出せます。） 

2. 確実にコネクタを接続した後、a.連結板(下)を被せ、①-2 で外したねじで止めます。 

③-1. 全体をひっくり返し、サラねじを外し、c.連結板(上)を b.ねじで連結します。 

2. リアパネルの TERMINATOR スイッチを設定します。 

・2 台までは、2 台とも TERMINATOR-ON 

・3 台以上は、両端を TERMINATOR-ON、間は TERMINATOR-OFF 

3. 各ユニットに付属の AC アダプタを接続して電源を入れ、MENU の MISC でアンプ ID と

LINK モードを設定します。（設定方法は、4.4.11 MISC をお読み下さい。） 

カバー 

カバー 

カバー 

b.ねじ (M3*8) 

c.連結板(上) 

c.連結板(下） 

カバーのねじ 

カバーのねじ 

a.連結板(上) 

A 
B 

C

c 
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第 4章 操作方法 
 

4.1. POWER ON 

 
1. 「3.5. 電源の接続」にしたがって SA-570ST に電源を供給して下さい。 

 

2. フロントパネルにある[STANDBY/ON]を押します。 

 

3. フロントパネルの各種インジケータが点灯し、モニタ表示に｢SA-570｣、設定表示には「ファーム 

ウェアバージョン」が表示されます。 

 

4. モニタ表示が｢SA-570｣から入力値または出力値に変われば、POWER ON 状態です。 

 

SA-570ST 本体は、前回の設定内容を保持してその内容で起動します。 

OFFキーを押しながら[STANDBY/ON] を押し、起動するまでOFFキーを押し続けると設定内容

を出荷時設定に戻すことができます。 

 

◇ 初めてセンサを接続する場合や仕様の異なるセンサに交換する場合 
初めてセンサを接続する場合や仕様の異なるセンサに交換する場合は、POWER OFF の状態

でセンサを接続し、ENTER キーを押しながら[STANDBY/ON]を押し、起動するまで ENTER

キーを押し続けて下さい。センサや外部機器の保護のため、ブリッジ電圧（EXC）無効、出力電

圧レンジ（OUT RANGE）無効、リモートセンス無し（R.SENSE/TEDS）の状態で起動します。 

これらの項目は、起動後にセンサの仕様に合わせて設定して下さい。 

尚、起動時は、ブリッジ電圧や出力電圧レンジが無効に設定されているなどの原因でアラームが

発生します。 

 注意 

・POWER ONから 15 分以上の予熱を行ってから測定して下さい。高精度の測定の場合は、30 分以上の予熱を行って下さい。 

・電源が立ち上がらない場合は、一旦、すべてのケーブルを本体からはずし、正しい接続を行い再起動して下さい。 

 

4.2. POWER OFF 

 
1. フロントアパネルにある[STANDBY/ON]を押します。 

 

2. 全てのインジケータの消灯で POWER OFF 状態です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 注意 

リアパネルのコネクタのケーブルを着脱する際は、必ず電源を切ってから行って下さい。 

 

POWER 
OFF 

ENTER キー 

POWER 
ON 

OFF キー 
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4.3. 表示切替 

SA-570ST は、入出力値をモニタ表示します。 

モニタ表示は、DSP MODE（ディスプレーモード切替）と MONITOR（LINK）（モニタ切替）で表示値を切り替えることができます。 

 

モニタ表示モード 切替 説明 

DSP MODE PEAK ピークの絶対値を表示し、PEAK インジケータが点灯します。 
MEAN 移動平均値を表示し、MEAN インジケータが点灯します。 

MONITOR(LINK) IN 入力値を表示し、IN インジケータが点灯します。 

（ストレインアンプモード時は、μST 表示/DC アンプモード時は mV 表示） 

但し、入力値（IN）はアンプ出力値からの換算値で、実際の入力値ではありません。 
OUT 出力値を電圧(V)表示し、OUT インジケータが点灯します。 

 

尚、MONITOR(LINK)は、LINK 操作時にも使用します。LINK キーを押しながら LINK対応キーを押すと機能します。 

（例 LINKキー＋BALANCE キーなど） 

 

 注意 

・DSP MODE(ディスプレイモード)の PEAK 表示は絶対値を表示します。 

・MONITOR(LINK)の入力(IN)で表示される値は、出力値（OUT）からの換算値です。実際の入力値ではありませんので注意して下さい。 

 

 

4.4. 各種設定 

SA-570ST の設定は、フロントパネルの MENU 項目を上下キーで選択します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MENU には、以下の 12 種類の項目があります。 

MENU 項目 機能 出荷時設定 
ON/OFF 設定値 

BALANCE オートバランス機能の ON/OFF、オートバランスの実行 ON － 

CAL キャリブレーションの実行、キャリブレーションレベルの設定 OFF 100% 

LPF ローパスフィルタの ON/OFF、カットオフ周波数の設定 OFF 10Hz 
HPF ハイパスフィルタの ON/OFF、カットオフ周波数の設定 OFF 1Hz 

SENSE 感度の設定（GAIN 設定） － ST：2000μST / DC：2.00mV 

OUT RANGE 出力電圧の ON/OFF、出力電圧レンジの設定 － 10V 
OUT SHIFT 出力電圧値のオフセットの ON/OFF、オフセット量の設定 OFF +50% 

EXC ブリッジ電圧値の設定 － 2V 
R.SENSE/TEDS リモートセンス有/リモートセンス無/TEDS の設定 － リモートセンス無し(----) 

STRAIN/DC アンプの動作モードの設定（ST/DC） － ストレインアンプモード（ST） 

MISC アンプ ID の設定、LINK モード（連動）の ON/OFF ON アンプ ID=1 
P.LOCK パネルロックの ON/OFF 、禁止タイプの設定 OFF TYPE 1 

 

 

MENU 項目のインジケータ（LED）は、橙色、赤色、黄緑色、消灯で以下の状態を示します。 

インジケータ色 状態 

橙色 MENU 項目が選択されている状態 

赤色 MENU 項目が選択され、その項目の機能が ON(有効)に設定されている状態 

黄緑色 MENU 項目が非選択で、その項目の機能が ON(有効)に設定されている状態 

消灯 MENU 項目が非選択、または非選択でその項目の機能が OFF(無効)に設定されている状態 

 

MENU項目 

上下キー 

MENU 項目のインジケータ 
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4.4.1 BALANCE (オートバランス) 

 

1. 上/下キーで MENU の BALANCE を選択します。 
設定表示に現在のオートバランスの ON/OFF の状態が表示されます。 

BALANCE では、オートバランス機能の ON/OFF 設定とオートバランス（ゼロバランス）が実行

できます。 

 

2. オートバランス機能の ON/OFF を設定します。 

 

・ONキーを押すと設定表示に ONが表示されオートバランス機能が有効になります。 

以前のオートバランスのバランス量で電圧が出力されます。 

ON 時は BALANCE キーの長押し（1 秒以上）でオートバランスが実行されます。 

 

・OFF キーを押すと設定表示に OFF が表示されオートバランス機能が無効になります。 

オートバランスのバランス量をキャンセルした電圧が出力されます。 

OFF 時は BALANCE キーを長押ししてもオートバランスは実行されません。 

 

3. オートバランスの実行 
オートバランスは、POWER ON から 15 分以上の予熱を行ってから実行して下さい。 

a. MONITOR キーで OUT（出力電圧表示）に設定します。 

b. ONキーでオートバランス ON に設定します。 

c. BALANCE キーを長押しして（1 秒以上）オートバランスを実行します。 

オートバランス実行中は、FINE が点滅します。 

オートバランスは現在の入力量をキャンセルするようにゼロバランスして出力電圧を 0V に 

します。 

d. オートバランス実行後に 左/右キー（－/＋）を押して 0V の微調整が可能です。 

（オートバランスを再実行すると微調整はキャンセルされます。） 

 

SA-570ST は、ストレインアンプモード時は、±10000μST まで、DC アンプモード時は、 

±30mV までのオフセット量をバランスさせることができます。 

この範囲を超えている場合はオートバランスアラームが発生します。 

 

◇ LINK 操作 

複数台の SA-570ST を LINK 接続している場合、BALANCE 項目では以下の LINK 操作ができます。 

 

LINK キー＋BALANCE キー ：LINK-ON でオートバランス ON している全ての SA-570ST でオートバランスが実行されます。 

 

注意：LINK 操作を続けて行う場合は、一度、LINK キーを放してください。 

 

 

注意 

・オートバランス機能を ONに設定した場合は、MENU の選択項目に関わらず BLANCE キーの長押しで（1 秒以上）オートバランスが実行されます。 

但し、LINK 操作の LINK キー＋BALANCE キーは、BALANCE 項目以外では実行できません。 

・高精度の測定の場合は、POWER ON から 30 分以上の予熱を行って下さい。 

選択 BALANCE キー 

MONITOR 

（LINK）キー 

ON キー OFF キー 

左右キー 

上下キー 
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4.4.2 CAL (キャリブレーション出力) 

 

1. 上/下キーで MENU の CAL を選択します。 
設定表示に現在の設定値が表示されます。 

CAL では、キャリブレーション出力の ON/OFF 設定とキャリブレーションレベルを設定できます。 

 

2. キャリブレーションレベルを設定します。 

a. ENTERキーを押すと現在設定されているキャリブレーションレベルが設定表示に点滅表示

されます。 

b. 上/下キーでキャリブレーションレベル 100P、50P のいずれかを選択します。 

100P：感度設定値（SENSE）の 100%に相当するひずみ量（STアンプモード）または 

電圧（DC アンプモード） 

 50P：感度設定値（SENSE）の 50%の相当するひずみ量（STアンプモード）または 

電圧（DC アンプモード） 

c. ENTER キーを押して確定します。選択をキャンセルする場合は OFF キーを押します。 

 

3. キャリブレーション出力の ON/OFF を設定します。 
 

・ONキーまたは、左/右キー（－/＋）を押すと設定表示にキャリブレーションレベルが表示され 

キャリブレーション電圧が出力されます。 

ON キーを押した場合のキャリブレーション電圧の極性（正負）は直前に選択された極性に

なります。ON の状態で左/右キー（－/＋）を押すと極性（正負）が切り替わります。 

尚、キャリブレーション電圧は入力電圧に重畳されます。 

 

・OFF キーを押すと設定表示に OFF が表示されキャリブレーション出力が OFF されます。 

 

◇ LINK 操作 

複数台の SA-570ST を LINK 接続している場合、CAL 項目では以下の LINK 操作ができます。 

 

LINK キー＋ONキー   ：LINK-ON している全ての SA-570ST でキャリブレーション電圧が出力されます。 

LINK キー＋OFF キー  ：LINK-ON している全ての SA-570ST でキャリブレーション電圧が OFF されます。 

LINK キー＋左キー（－） ：LINK-ON している全ての SA-570ST でキャリブレーション電圧が負になります。 

LINK キー＋右キー（＋） ：LINK-ON している全ての SA-570ST でキャリブレーション電圧が正になります。 

 

LINK 操作時のキャリブレーション電圧は、個々のアンプで設定したキャリブレーションレベルになります。 

 

注意：LINK 操作を続けて行う場合は、一度、LINK キーを放してください。 

 

 

注意 

・ストレインアンプモードの場合は感度(SENSE)に 10000μST を超える値を設定するとキャリブレーションレベルは 50P(50%)までになります。この時に

100P(100%)を選択すると CAL オーバーアラームが発生します。 

・キャリブレーション電圧は入力電圧に重畳されます。 

 

選択 

ENTER キー 

左/右キー 

ON キー OFF キー 

上/下キー 

LINK キー 
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4.4.3 LPF （ローパスフィルタ） 

 

1. 上/下キーで MENU の LPF を選択します。 
設定表示に現在の設定値が表示されます。 

LPF では、ローパスフィルタの ON/OFF 設定とカットオフ周波数を設定できます。 

 

2. カットオフ周波数を設定します。 

a. ENTER キーを押すと現在設定されているカットオフ周波数の入力桁が点滅表示します。

入力可能な上位 2 桁が点滅します。 

b. 左/右キーを押して桁の位置を設定します。（上位 2 桁が移動します） 

c. 上/下キーを押して希望の値に設定します。 

上/下キーの長押しで上の桁を変更できます。 
（10Hz～10000Hz の範囲で上位 2 桁が変更可能です。） 

d. ENTERキーを押して確定します。設定値をキャンセルする場合は、OFFキーを押します。 

 

3. ローパスフィルタの ON/OFF を設定します。 
 

・ON キーを押すと設定表示にカットオフ周波数が表示され、ローパスフィルタが有効になりま

す。 

 

・OFF キーを押すと設定表示に OFF が表示され、ローパスフィルタが PASS になります。 

 

 

4.4.4 HPF （ハイパスフィルタ） 

 

1. 上/下キーで MENU の HPF を選択します。 
設定表示に現在の設定値が表示されます。 

HPF では、ハイパスフィルタの ON/OFF 設定とカットオフ周波数を設定できます。 

 

2. カットオフ周波数を設定します。 

a. ENTER キーを押すと現在設定されているカットオフ周波数の入力桁が点滅表示します。

入力可能な上位 2 桁が点滅します。（1Hz～9Hz までは 1 桁が点滅します。） 

b. 左/右キーを押して入力桁の位置を設定します。（上位 2 桁が移動します） 

c. 上/下キーを押して希望の値に設定します。 

上/下キーの長押しで上の桁を変更できます。 
（1Hz～9900Hz の範囲で上位 2 桁が変更可能です。） 

d. ENTERキーを押して確定します。設定値をキャンセルする場合は、OFFキーを押します。 

 

3. ハイパスフィルタの ON/OFF を設定します。 
 

・ON キーを押すと設定表示にカットオフ周波数が表示され、ハイパスフィルタが有効になりま

す。 

 

・OFF キーを押すと設定表示に OFF が表示され、ハイパスフィルタが PASS になります。 

 

 

注意 

1.0KHz 以上のハイパスフィルタを設定した場合は、出力が最大 1.5dB 減衰します。（7.5 ハイパスフィルタ特性を参照） 

 

選択 

ENTER キー 

左/右キー 

ON キー OFF キー 

上/下キー 

選択 

ENTER キー 

左/右キー 

ON キー OFF キー 

上/下キー 
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4.4.5 SENSE (感度) 

 

1. 上/下キーで MENU の SENSE を選択します。 
設定表示に現在の感度値が表示されます。 

SENSE では、感度設定ができます。 

・ストレインアンプモード時は、ひずみ量単位（μST）となり、感度設定したひずみ量が入力され

ると OUT RANGE で設定された電圧が出力されます。 

・DC アンプモード時は、電圧単位(mV）となり、感度設定した電圧が入力されると OUT 

RANGE で設定された電圧が出力されます。 

 

2. 感度（SENSE）を設定します。 

a. ENTER キーを押すと現在設定されている感度値が設定表示に表示され、入力桁が 

点滅表示します。 

b. 左/右キーを押して入力桁の位置を設定します。 

c. 上/下キーを押して希望の値に設定します。 

・ストレインアンプモードの場合：ブリッジ電圧により以下の範囲で設定します。 

 

 

 

 

 

 

ブリッジ電圧により最小感度値に制限があります。 

・DC アンプモードの場合：2mV～105mV の範囲で設定します。 

d. ENTERキーを押して確定します。設定値をキャンセルする場合は、OFFキーを押します。 

 

◇ ブリッジ電圧（EXC）と感度設定（SENSE）の関係について 

通常、ひずみ電圧出力は、同じひずみ量でもブリッジ電圧を変えるとブリッジ電圧に比例して変化します。 

SA-570ST は、内部でブリッジ電圧毎に感度較正しますのでブリッジ電圧を考慮せず感度設定することができます。 

 

 

 

ひずみ単位（×10-6ひずみ）とトランスデュ－サの出力定格単位（mV/V）の換算について 
 

ひずみゲージ式トランスデューサの出力はひずみ量（ｘ10-6ひずみ）とブリッジ電圧に１Ｖを加えた時の出力電圧（mV/V）表記があります。 

ひずみ量εとブリッジよりの出力電圧 V の関係はブリッジ印加電圧を B.V、ゲージ率を G.F とすると１ゲージ方では次のような関係があります。 

 

 

 

 

 

 

        ゲージ率を 2.0 とすると 

 

 

 

Ｂ．Ｖ を 1V とすると  ２・Ｖ ＝εとなります。 

 

SA-570ST はゲージ率 2.0 で較正されていますので、ひずみ量単位（ｘ10-6ひずみ）をトランスデユーサ出力単位（mV/V）にするには 0.5 倍します。 

例えば 4000ｘ10-6ひずみは 2.0mV/V（2000μV/V）となります。 

 

尚、SA-570ST 本体や本マニュアルは、ひずみ量単位を｢ｘ10-6ひずみ｣または「μST」で表記しています。 

 

 

 

注意 

・ストレインアンプモード時、感度に 10000μST を超える値を設定した場合は、CAL で出力できるキャリブレーションレベルは 50P（50%）までになります。

100P(100%)を設定してキャリブレーション出力を ONにすると CAL オーバーアラームが発生します。 

・感度設定の上限は 20000μST ですが、ブリッジ電圧により下限の感度設定値に制限があります。（2.- c. の表を参照）. 誤った設定を行うとゲイン不

足アラームが発生します。 

ブリッジ電圧 感度の設定範囲 

1V 4000μST ～ 20000μST 

2V 2000μST ～ 20000μST 

5V 800μST ～ 20000μST 

10V 400μST ～ 20000μST 

選択 

ENTER キー 

左/右キー 

上/下キー 
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4.4.6 OUT RANGE （出力電圧レンジ） 

 

1. 上/下キーで MENU の OUT RANGE を選択します。 
設定表示に現在の出力電圧レンジが表示されます。 

OUT RANGE では、出力電圧レンジの設定ができます。 

 

2. 出力電圧レンジ(OUT RANGE)を設定します。 

a. ENTER キーを押すと設定表示の電圧値（レンジ）が点滅表示します。 

b. 上/下キーを押して ----、1V、2V、5V、10V のいずれかを選択します。 

----は、出力を無効に設定します。(出力電圧回路への電源供給を遮断します。) 

c. ENTER キーを押して確定します。選択をキャンセルする場合は、OFF キーを押します。 

d. 左/右キー（－/＋）を押して出力電圧を FINE 調整（出力電圧レンジの約 1/3～1 倍）

できます。FINE 調整した場合は、FINE インジケータが点灯します。 

 

FINE 調整のキャンセルは、FINE インジケータが消えるまで右キー（＋）を押すか、 

再度、a.～c. の出力電圧レンジ設定を行います。 

 

 

 

 

 

 

 

 

◇ OUT RANGE の許容出力電圧について 

SA-570ST の直線性の保証されている最大出力電圧は±10Ｖです。 

最大入力の範囲内で SA-570ST の出力電圧は OUT RANGE の設定電圧を超え、下記の電圧まで直線性が保証されます。 

 
OUT RANGE 出力電圧 

1V ±5V 

2V ±10V 

5V ±10V 

10V ±10V 

 

例えば、SENSE 設定 2000μST で OUT RANGE 2V の場合、最大入力±10000μST（出力電圧 10V）まで測定可能となります。 

 

 

4.4.7 OUT SHIFT （出力電圧オフセット） 

 

1. 上/下キーで MENU の OUT SHIFT を選択します。 
設定表示に現在の出力電圧オフセット量がパーセント表示されます。 

OUT SHIFT では、出力電圧オフセットの ON/OFF 設定とオフセット量の設定ができます。 

 

2. オフセット量(OUT SHIFT)を設定します。 

a. ENTER キーを押すと設定表示にオフセット量が点滅表示します。 

b. 上/下キーを押して -100P～+100P まで(10P 単位）のいずれかを選択します。 

オフセット量は、出力電圧レンジの-100%～+100%まで（10%単位）設定できます。 

c. ENTER キーを押して確定します。選択をキャンセルする場合は、OFF キーを押します。 

 

3. OUT SHIFT の ON/OFF を設定します。 
 

・ON キーを押すと設定表示に出力電圧のオフセット量が表示され、オフセットが有効になりま

す。 

 

・OFF キーを押すと設定表示に OFF が表示され、オフセットが無効になります。 

 

 

選択 

ENTER キー 

左/右キー 

ON キー OFF キー 

上/下キー 

選択 

ENTER キー 

左/右キー 

上/下キー 

FINE 

インジケータ 
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4.4.8 EXC （ブリッジ電圧） 

 

1. 上/下キーで MENU の EXC を選択します。 
設定表示に現在のブリッジ電圧(EXC)が表示されます。 

EXCでは、ブリッジ電圧の設定ができます。 

 

2. ブリッジ電圧(EXC)を設定します。 

a. ENTER キーを押すと設定表示の電圧値が点滅表示します。 

b. 上/下キーを押して ----、1V、2V、5V、10V のいずれかを選択します。 

----は、出力を無効に設定します。(出力電圧回路への電源供給を遮断します。) 

c. ENTER キーを押して確定します。選択をキャンセルする場合は、OFF キーを押します。 

 

 

 

 

 

 

注意 

ブリッジ電圧の設定は、接続するセンサの規格に合わせて行って下さい。誤った設定を行うとセンサを壊す恐れがあります。 

 

 

4.4.9 R.SENSE/TEDS （リモートセンス/TEDS） 

 

1. 上/下キーで MENU の R.SENSE/TEDS を選択します。 
設定表示に現在の設定値が表示されます。 

R.SENSE/TEDSでは、ブリッジ電圧のリモートセンスの有無または TEDS設定、及び TEDS

の読み込みができます。 

 

2. リモートセンス/TEDS(R.SENSE/TEDS)を設定します。 

a. ENTER キーを押すと設定表示の設定値が点滅表示します。 

b. 上/下キーを押して ----、rSEnS、tEdS のいずれかを選択します。 

---- ：ブリッジ電圧のリモートセンスを使用しない。 

r.SEnS ：ブリッジ電圧のリモートセンスを使用する。 

tEdS ：TEDS 対応センサを使用する。 

c. ENTER キーを押して確定します。選択をキャンセルする場合は、OFF キーを押します。 

 

3. TEDS の読み込み。 
TEDS センサを使用する場合は、最初に TEDS センサの読み込みを行います。 

以下の手順で TEDS の読み込みを実行します。 

 

a. R.SENSE/TEDS で ｔEdS を設定した状態で TEDS センサを接続します。 

b. ONキーを押すと TEDS 読み込みが実行され、レベルメータが左端から点灯します。 

c. レベルメータが+100％まで点灯すると読み込み完了です。（10～15 秒程度） 

d. 設定された感度（SENSE）とブリッジ電圧（EXC）を確認します。 

 

TEDS 読み込みによって感度（SENSE） とブリッジ電圧（EXC）が自動的に設定されます。 

感度はセンサの定格値が設定されますので必要に応じて感度値を調整して下さい。 

 

 

 

 

 

 

注意 

ブリッジ電圧のリモートセンスを使用するに設定した状態でリモートセンス未対応のケーブルを接続すると[Err.  1]の BV エラーが発生します。 

 

選択 

ENTER キー 

左/右キー 

上/下キー 

選択 

ENTER キー 

左/右キー 

上/下キー 

ON キー 

ON キー：TEDS 読み込み 

TEDS 読み込み中

を示すインジケータ 

TEDS 読み込みの例 
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4.4.10 STRAIN/DC （アンプモード切替） 

 

1. 上/下キーで MENU の STRAIN/DC を選択します。 
設定表示に現在の設定値が表示されます。 

STRAIN/DC では、ストレインアンプモードと DC アンプモードの切り替えができます。 

 

2. アンプモード（STRAIN/DC）を切り替えます。 

a. ENTER キーを押すと設定表示のアンプモードが点滅表示します。 

b. 上/下キーを押して ｄC、Stのいずれかを選択します。 

dC ：DC アンプモード 

St ：ストレインアンプモード 

c. ENTER キーを押して確定します。選択をキャンセルする場合は、OFF キーを押します。 

設定したアンプモードの ST/DC インジケータが点灯します。 

 

 

 

 

 

MEMO: 
 
 

選択 

ENTER キー 

左/右キー 

上/下キー 

ST/DC 

インジケータ 
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4.4.11 MISC （アンプ ID と LINKモード） 

 

1. 上/下キーで MENU の MISC を選択します。 
設定表示に現在のアンプ ID と LINK モードが表示されます。 

MISC では、アンプ IDの設定、LINK モードの ON/OFF の設定ができます。 

 

2. アンプ ID を設定します。 

a. ENTER キーを押すと設定表示の ID が点滅表示します。 

LINKの ON/OFF 表示は消灯します。 

b. 上/下キーを押して 1 から８のいずれかを選択します。 

連結するアンプは全て異なるアンプ ID を設定します。(１～８を設定) 

アンプ ID は左端のアンプから昇順に割り振ることを推奨します。 

c. ENTER キーを押して確定します。選択値をキャンセルする場合は、OFF キーを押します。 

 

3. LINK モードの ON/OFF を設定します。 
LINK 接続されたアンプの LINK 操作への対応を設定します。 

・ONキーを押すと設定表示にONが表示され、LINKモードが有効になります。（LINK-ON） 

ON に設定されたアンプは LINK 操作に応答して動作します。 

 

・OFF キーを押すと設定表示に OFF が表示され、LINK モードが無効になります。

(LINK-OFF) 

OFF に設定されたアンプは LINK操作に応答しません。 

 

◇ LINK 操作 

1. 複数台の SA-570ST を LINK接続している場合、MISC 項目では以下の LINK 操作ができます。 

 

LINK キー＋ENTER キー  ：LINK-ON している全ての SA-570ST に LINK操作したアンプの設定値をコピーします。 
  

a. LINKキー＋ENTER キーを押すと設定表示に[ COPY ]が点滅表示します。 

b. ENTER キーを押してコピーを実行します。キャンセルする場合は、OFF キーを押します。 

 

コピー操作によって以下の項目を除き、全ての設定内容が他のアンプにコピーされます。 

 

コピーされない項目 

SENSE 
EXC 
R.SENSE/TEDS 
MISC 

 

 

 

 

2. 他の MENU 項目で操作できる LINK 操作 

・BALANCE 項目で操作できる LINK 操作 

LINK キー＋BALANCE キー ：LINK-ON でオートバランス ON している全ての SA-570ST でオートバランスが実行されます。 

 

・CAL 項目で操作できる LINK 操作 

LINK キー＋ONキー ：LINK-ON している全ての SA-570ST でキャリブレーション電圧が出力されます。 

LINK キー＋OFF キー ：LINK-ON している全ての SA-570ST でキャリブレーション電圧が OFF されます。 

LINK キー＋左キー（－） ：LINK-ON している全ての SA-570ST でキャリブレーション電圧が負になります。 

LINK キー＋右キー（＋） ：LINK-ON している全ての SA-570ST でキャリブレーション電圧が正になります。 

 

LINK 操作時のキャリブレーション電圧は、個々のアンプで設定したキャリブレーションレベルになります。 

 

注意：LINK 操作を続けて行う場合は、一度、LINK キーを放してください。 

 

注意 

SA-570ST は複数台を連結すると BALANCE や CAL の LINK 操作及び USB 接続した PCからの各種設定やモニタ表示が可能です。 

MISC は複数台を連結する場合に設定する項目ですので、単独でご使用の場合は、MISC を変更する必要はありません。 

OFF キー 

ENTER キー 

LINK キー 

選択 

ENTER キー 

左/右キー 

ON キー OFF キー 

上/下キー 

LINK キー 

ア ンプ
ID 

LINK モード 
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4.4.12 P.LOCK （パネルロック） 

 

1. 上/下キーで MENU の P.LOCK を選択します。 
設定表示に現在の ON/OFF 状態が表示されます。 

P.LOCKでは、禁止タイプの設定と P.LOCK の ON/OFF の設定ができます。 

 

2. 設定変更の禁止タイプ(P.LOCK TYPE)を設定します。 

a. P.LOCK-ON の状態であれば、OFF キーを押して設定禁止を解除します。 

b. ENTER キーを押すと設定表示に tyPE が点滅表示します。 

c. 上/下キーを押して tyPE 1、tyPE 2 のいずれかを選択します。 

tyPE 1 ：BALANCE キーを含め、設定変更を禁止します。 

tyPE 2 ：P.LOCK-ON の状態でも BALANCE キー（オートバランス）は有効です。 

d. ENTER キーを押して確定します。選択をキャンセルする場合は、OFF キーを押します。 

 

3. 設定変更の禁止（P.LOCK）の ON/OFF を設定します。 
 

・ONキーを押すと設定表示に ONが表示され、設定変更が禁止になります。 

P.LOCK-ON の状態でも下記の操作は可能です。 

・上下キーでの MENU 項目の設定値の確認 

・DSP MODE キーでの PEAK/MEAN 切り替え 

・MONITOR キーでの IN/OUT 切り替え 

・禁止タイプを tyPE 2 に設定した場合は、BALANCE キーでのオートバランスの実行 

 

・OFF キーを押すと設定表示に OFF が表示され、P.LOCK が解除されます。 

 

◇ LINK 操作 

複数台の SA-570ST を LINK 接続している場合、P.LOCK 項目では以下の LINK 操作ができます。 

 

LINK キー＋ONキー ：LINK-ON している全ての SA-570ST でパネルロックします。（P.LOCK-ON） 

LINK キー＋OFF キー ：LINK-ON している全ての SA-570ST でパネルロックが解除します。(P.LOCK-OFF) 

 

注意：LINK 操作を続けて行う場合は、一度、LINK キーを放してください。 

 

注意 

P.LOCK-ON で設定内容の変更操作を行うと設定表示に [ - PL - ] のアラームが 2 秒間点滅表示されます。 

 
 

4.4.13 LINK操作一覧 

複数台の SA-570ST を LINK 接続している場合、各 MENU 項目で以下の LINK 操作ができます。 

 

MENU 項目 LINK 操作 LINK 動作 

全ての項目 
LINK キー＋上キー LINK-ON している全ての SA-570ST で同じMENU 項目に移動します 

LINK キー＋下キー LINK-ON している全ての SA-570ST で同じMENU 項目に移動します 

BALANCE LINKキー＋BALANCE キー LINK-ON でオートバランス ON している全ての SA-570ST でオートバランスが実行されます 

CAL 

LINK キー＋ON キー LINK-ON している全ての SA-570ST でキャリブレーション電圧が出力されます 

LINK キー＋OFF キー LINK-ON している全ての SA-570ST でキャリブレーション電圧が OFF されます 

LINK キー＋左キー（－） LINK-ON している全ての SA-570ST でキャリブレーション電圧が負になります 

LINK キー＋右キー（＋） LINK-ON している全ての SA-570ST でキャリブレーション電圧が正になります 

注意：LINK 操作時のキャリブレーション電圧は、個々のアンプで設定したキャリブレーションレベル(100%、50%)になります 

MISC LINK キー＋ENTER キー LINK-ON している全ての SA-570ST に LINK 操作したアンプの設定値をコピーします 
P.LOCK LINK キー＋ON キー LINK-ON している全ての SA-570ST でパネルロックします。 

LINK キー＋OFF キー LINK-ON している全ての SA-570ST でパネルロックが解除します。 

注意：LINK 操作を続けて行う場合は、一度、LINK キーを放してください。 

 

 

MONITOR(LINK)

キー 

BALANCE キー 

選択 

ON キー OFF キー 

上/下キー 

DSP  

MODE キー 

ENTER キー 
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4.5. アラームとエラー 

SA-570ST は、アラームやエラーが発生すると ALARM インジケータが点滅又は点灯し、アラームまたはエラーを表示します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.5.1. アラーム 

SA-570ST は、ALARM インジケータを点滅または点灯し、警告を以下のように表示します。 

 

1. SA-570ST のアラーム表示（ALARM インジケータが点滅または点灯） 

アラーム（モニタ表示） 番号 アラーム名 原因 対策 

  

アラーム１ 

 

A/D オーバーフロー 

アラーム 

出力値が大きすぎる。 

 

入力を小さくする。または、

SENSE の感度設定を見直

す。 

 

アラーム２ 

 

ゲイン不足アラーム 

 

感度値が大きすぎる。 ブリッジ電圧に対応した感度

値を設定する。 

 

アラーム３ 

 

出力シフトオーバーフロー 

アラーム 

 

- 

弊社サポート部門にご連絡

下さい。 

 

アラーム４ 

 

オートバランスアラーム 入力値がバランス範囲を

超えている。 

入力信号や感度値を見直

し、再び、オートバランスを行

う。 

 

アラーム５ 

 

CAL オーバーアラーム 

 

感度値が 10000μST を

超えている。 

SENSE の感度値、または、

CAL のレベルを見直す。 

  

 

－ 

 

 

アナログ出力アラーム 

 

 

出力値が大きすぎる。 

（±10.5V 以上） 

入力を小さくする。または、

SENSE の感度設定を見直

す。 

 

アラーム１～アラーム５は、モニタ表示の最上位桁の 7 セグメント LED の点灯位置で示します。 

アラーム 2 

アラーム 3 

アラーム１ 

アラーム 5 

アラーム 4 

アラーム１の表示例 

例 

アラーム 1 を表示 

点滅 

または

点灯 

モニタ表示にアラームコード

やエラーコードを表示 

アラームやエラーが発生すると

ALARM インジケータが点滅または 

点灯します 

エラーコードを表示 設定表示にアラームやエラーを

表示する場合もあります 
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2. パネルロック（P.LOCK）や PC 接続して設定変更禁止の状態で、設定変更の操作を行うと ALARM インジケータが点灯し、設定表示に [ - PL - ] 

または [ - PC - ] を 2 秒間点滅表示して警告します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.5.2. エラー 

SA-570ST は、ALARM インジケータが点滅し、エラーを以下のように表示します。 

 

1. SA-570ST のエラー表示（起動時のエラーで ALARM インジケータが点滅） 

モニタ表示 設定表示 エラー名 原因 対策 

Error Para. 設定値エラー 設定値に欠損がある。 いずれかのキーを押すと出荷時設定で起動します。 

F.Error LoSt.Co 調整値エラー１ － 弊社サポートへお問い合わせ下さい。 

F.Error Corr. 調整値エラー２ － 弊社サポートへお問い合わせ下さい。 

 
 
 
 
 
 
 
 
 
 
 
 

2. SA-570ST のエラー表示（通常動作時のエラーで ALARM インジケータが点滅） 

エラーコード（モニタ表示） エラー名 原因 対策 

  

BV エラー 

 

R.SENSE/TEDSでリモートセンス有効を設

定しているのにリモートセンス端子（INPUTコ

ネクタ）が接続されていない。 

リモートセンス端子を正しく接続する または

R.SENSE/TEDS でリモートセンス無しに設定

する。 

  

低電圧エラー 

 

電源電圧が低い。 ・AC アダプタ出力が低下している 

・直接 DC 電圧を入力している場合は、供給

源に異常がないかを確認する。 

  

TERMINATOR エラー 

 

リアパネルの TERMINATORスイッチの設定

に誤りがある。 

 

1 台でご使用の場合は TERMINATOR-ON

する。複数台で LINK 接続している場合は両

端の TERMINATOR-ON、他は OFF する。 

  

通信エラー 

 

LINK 接続した SA-570ST 間の通信に問

題がある。 

アンプ ID、TERMINATOR ON/OFF 設定を

確認する。または、LINK 接続ケーブルを確認

する。 

  

TEDS 読み込みエラー 

 

TEDS センサの読み込みができない。または 

テンプレート ID が異なる。 

TEDS センサの種類、接続及びケーブルを 

確認して、再度 TEDS 読み込みを行う。 

  

TEDS 比較エラー 

 

起動時の TEDS 読み込みに失敗または、

読み込んだ情報と設定情報が不一致。 

TEDS センサの接続、ケーブルを確認する。 

またはR.SENSE/TEDSで TEDSセンサの使

用を解除する。 

 

 

注意 

エラーが発生した場合は、エラーコードを確認し対策を行って下さい。エラーが解除されない場合は、電源を入れ直して正常動作を確認して下さい。 

調整値エラー１

２ 
調整値エラー２ 設定値エラー

１ 

パネルロック中の変更操作アラーム PC 接続中の変更操作アラーム 
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第 5章 プログラムのインストールと起動・終了 
 

5.1. プログラムのインストール 

 

 注意 

SA-570 Navi プログラムの推奨動作環境は以下の通りです。 

 

CPU:   Pentium IV 2 GHz 以上 

OS:  Windows Vista、Windows 7、Windows 8.1、Windows 10 

メモリ:  1GB 以上 

画面の解像  1024×768 ピクセル以上 

HDD 空き容量 2GB 以上 
USBインターフェース:  OHCIまたはUHCIに対応したUSB1.1または2.0インターフェース  
CD-ROMドライブ: 付属ユーティリティディスク読み取り用 
 

 

1. プログラムのインストール前に SA-570ST 本体を PCに接続しないで下さい。 

 

2. 付属のCDのをCDドライブに挿入するとセットアッププログラムが自動起動します。自動起動し

ない場合は、付属 CD の中の Setup.exe を実行して下さい。 

SA-570 Navi のセットアップが開始され左の画面が表示されますので、画面の指示に従ってインス

トールして下さい。 

 

 

 

 

 

 

 

3. ディレクトリには、左記のアイコンで示されるSA-570 Navi実行ファイルとともに、次のファイルが

コピーされます。 

 

ファイル名・フォルダ名 内容 

SA570Navi.exe プログラム実行ファイル 

Wave02.dll バーメータ－表示用 dll 

Wave03.dll デジタル表示用 dll 

SA570Ctrl.dll SA-570ST 制御用 dll 

SA-570ST_UsersManuaｌ.pdf ユーザーズマニュアル 

SA-570ST_OutlineManuaｌ.pdf 簡易取扱説明書 

SA-570ST_OutlineManual_Klite.pdf KLITE 圧力トランスデューサ用簡易取扱説明書 

Driver ドライバー関連フォルダ 

 
 

5.2. SA-570 ドライバーのインストール 

 

1. [スタートメニュー⇒すべてのプログラム⇒TEAC⇒SA-570]内※の SA-570 Driver を実行し

て下さい。SA-570 Driver のセットアップが開始され左の画面が表示されますので、画面の指示に

従ってインストールして下さい。 

※Windows 8.1 の場合はアプリケーション画面 

 

 

 

 

 

 

2. ドライバーのインストールが完了したら SA-570STを市販の USB2.0ケーブルで PCに接続し、

SA-570ST の電源を ON して認識させます。 
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5.3. プログラムの起動・終了 

1. [スタートメニュー⇒すべてのプログラム⇒TEAC⇒SA-570]内※の SA-570 Navi を実行して

下さい。 

※Windows 8.1 の場合はアプリケーション画面 

 

起動時、接続に失敗した場合には、ツールバーに<NO CONNECT>と表示されます。 

再接続する場合は、メニューバーの[Control -> Connect]をクリックして下さい。 

 

 

 

2. プログラムを終了するには、ウィンドウ右上の       をクリック、または、メニューバーの 

[File] ⇒ [Exit] をクリックします。 

 

 

 

注意 

PC のスタンバイ・スリープ・休止状態には対応していません。 

上記の状態後は、SA-570 Navi を終了し、SA-570ST の電源を入れなおしてください。 

 

 
 

MEMO: 
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5.4. SA-570 Naviの各メニュー 

SA-570 Navi の各メニューは以下の通りです。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

（メニューバー詳細） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

File Exit   SA-570 Navi プログラムを終了します。 

 Save Parameter  現在の SA-570ST 本体の設定をファイルに保存します。 

 Load Parameter  予め保存した設定ファイルを読み出して、SA-570ST 本体に設定を行います。 

 

Control Setup   SA-570 設定情報を表示します。 

 Monitor In/Out  モニター値をアンプ入力又は出力相当にします。（へこんだ状態が出力相当） 

 Monitor Peak/Mean  モニター値を絶対値ピーク又は平均値相当にします。（へこんだ状態が平均値相当） 

 Cal. Output -100%  CAL 出力（Range -100%相当）を行います。 

 Cal. Output -50%  CAL 出力（Range -50%相当）を行います。 

Cal. Output +50%  CAL 出力（Range +50%相当）を行います。 

Cal. Output +100%  CAL 出力（Range +100%相当）を行います。 

Panel Lock   パネルロックの ON/OFF を行います。 

Panel Lock (exclude ZeroBalance) BALANCE キーを除き、パネルロックの ON/OFF を行います。 

   （パネルロック ON の状態でオートバランス（ゼロバランス）は実行可能） 

Connect   SA-570ST との通信の接続/切断を行います。 

 

View Toolbar   ツールバーの表示/非表示を行います。 

 Status Bar   ウィンドウ下のステータスバーの表示/非表示を行います。 

 Bar Monitor   バーモニターを最前面表示します。 

 Digital Monitor  デジタルモニターを最前面表示します。 

 

Help About SA-570 Navi SA-570 Navi プログラムのバージョン情報を表示します。 

 Firm Update  SA-570 のファームウェアを更新します。 

ツールバーの各アイコンをクリックすると該当機能を起動します。 

メニューバーの各項目をクリックすると該当機能を起動します。 

ステータスバー 
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（ツールバー詳細） 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

MEMO: 
 
 

 

SA-570ST 設定情報を表示しま

す。 
モニター値をアンプ入力又は出力相当にします。（へこんだ状態が出力相当） 

CAL 出力を行います。（左から Range -100%、-50%、50%、100%相当） 

モニター値をピーク又は実効値相当にします。（へこんだ実行値が出力相当） 

デジタルモニターを最前面表示します。 

モニター値のピークホールドをクリアします。 

バーモニターウィンドウを最前面表示します。 

SA-570 Navi プログラムのバージョン情報を表示します。 

SA-570ST との接続状態を表示します。 
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第 6章 プログラムの操作 
 

6.1. 主条件設定 

 

メニューバー [Control] ⇒ [Setup] 若しくは、ツールバー     をクリックすると、<Setup>ダイアログが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

項目を変更する場合は、設定情報リスト上の任意のアンプを選択した（青く反転させた）後、リスト下部の各項目を変更します。 

 

<Setup>ダイアログでは下記項目が設定できます。 

 

アンプモード  下記モードより選択 

ST ストレインアンプモード  ST ストレインアンプ TEDS モード 

ST（RS） ストレインアンプリモートセンスモード DC 直流アンプモード 

センス（感度） ST uST 単位 

   （mV/V のトランスデューサについては、1 mV/V = 2000 uST で計算した値を入力下さい。） 

  DC mV 単位 

TEDS 対応トランスデューサ接続時、ストレインアンプ TEDS モードで TEDS 情報読み込み 

出力レンジ  センスあたりの出力値 

無効 / 1 / 2 / 5 / 10 V より選択 

  また、ファインゲインにより、レンジの 1/3～1 倍まで調整が可能（出力レンジの 0.1%単位） 

出力電圧オフセット 出力値のオフセット設定 

  出力レンジの-100%～+100%まで調整が可能（出力レンジの 10%単位） 

ブリッジ電圧  DC 方式のブリッジ電圧設定 

 無効 / 1 / 2 / 5 / 10 V より選択 

ハイパスフィルター OFF / ON の選択および 

カットオフ周波数 1～9900 Hz の選択が可能 

（10～9900 Hz については上位 2 桁の変更） 

ローパスフィルター OFF / ON の選択および 

カットオフ周波数 10～10000 Hz（上位 2 桁）の選択が可能 

（10～9900 Hz については上位 2 桁の変更） 

オートバランスモード オートバランス OFF / ON の設定および 

（ゼロバランス） オートバランス実行、バランス微調整が可能 

LINK モード  LINK モードの OFF / ONの設定 

 

 

注意 

SA-570 Navi は LINK モードの ON/OFF 設定に関わらず接続された全てのユニットにアクセスすることができます。 

アンプモード 

センス（感度） 

出力レンジ 

出力レンジシフト 

ブリッジ電圧 

ハイパスフィルター（ON/OFF） 

ローパスフィルター（ON/OFF） 

バランスモード（ON/OFF） 

出力レンジ微調整（ファインゲイン） 

ハイパスフィルター（カットオフ周波数） 

ローパスフィルター（カットオフ周波数） 

バランスモード微調整（＋方向） 

バランスモード微調整（－方向） 

オートバランス実行 
ダイアログの終了 

選択（反転）表示状態（左クリックで指定） 

リンクモード（ON/OFF） 

更新 

更新 更新 

TEDS 読込 

設定情報リスト 最大 8 台の SA-570ST 設定を表示します。 
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6.2. モニター出力 

 

メニューバー [Control] ⇒ [Monitor In/Out] 若しくは、ツールバー     をクリックすると、SA-570ST 本体若しくはアプリケーション上でのモニター値が 

 

トランスデューサからのアンプ入力相当かアンプ出力相当かを選択できます。 

アンプ出力相当の場合には、該当ツールボタンがへこんだ状態になります。 

 

モニター値の単位は、 

アンプ入力相当のとき アンプモードがストレインモード uST 

  アンプモードが DC モード  mV 

アンプ出力相当のとき    V 

となります。 

 
 

メニューバー [Control] ⇒ [Monitor Peak/Mean] 若しくは、ツールバー      をクリックすると、SA-570ST 本体若しくはアプリケーション上でのモニタ 

 

値が、ある一定間隔のピーク値相当か実効値相当かを選択できます。 

実効値相当の場合には、該当ツールボタンがへこんだ状態になります。 

 

変更した際には、バーモニターのピークホールドもリセットされます。 

 

注意：SA-570ST を複数台接続した場合、アンプ接続(CONNECT)時に[Monitor In/Out]及び[Monitor Peak/Mean]の値は、最小アンプ ID の

SA-570STの設定値が反映されます。[Monitor In/Out]及び[Monitor Peak/Mean]の操作を行うと全ての SA-570STに変更した項目の値が設定されま

す。 

 

6.3. CAL 出力 

 

メニューバー [Control] ⇒ [Cal. Output ＊＊%] 若しくは、ツールバー                 をクリックすると、レンジ設定＊＊%に相当するキャル 

 

出力を行います。（ツールボタン左から、レンジ設定の－100%、－50%、＋50%、＋100%） 

キャル出力時には、該当ツールボタンがへこんだ状態になります。 

 

キャル出力を停止する際には、へこんだ状態のツールボタンを再度クリックします。 

 

注意：SA-570STを複数台接続した場合、アンプ接続(CONNECT)時に[CAL ON/OFF]及び[CAL RANGE]の値は、最小アンプ IDの SA-570ST の設

定値が反映されます。CAL 出力の操作を行うと全ての SA-570STに[CAL ON/OFF]及び[CAL RANGE]の値が設定されます。 

 

6.4. パネルロック 

 

メニューバー [Control] ⇒ [Panel Lock]または[Panel Lock (exclude ZeroBalance)]をクリックすると、SA-570ST本体パネルロックのON/OFFを行

います。パネルロック ONの場合には、該当メニュー項目左にチェックがつきます。 

 
Panel Lock は、BALANCE キーを含み全ての設定変更を禁止します。(type1) 

Panel Lock (exclude ZeroBalance) は、BALANCE キーを除き、設定変更を禁止します。（type2）  

Panel Lock (exclude ZeroBalance)-ON ではオートバランス（ゼロバランス）が実行可能です。 

 

パネルロックは、SA-570ST 本体のパネル操作での設定変更をロックします。 

 

注意：SA-570STを複数台接続した場合、アンプ接続(CONNECT)時に[Panel Lock]または[Panel Lock (exclude ZeroBalance)] は、最小アンプ

ID の SA-570STの設定値が反映されます。[Panel Lock]または[Panel Lock (exclude ZeroBalance)] の操作を行うと全ての SA-570STに設定され

ます。 
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6.5. モニター表示 

 

メニューバー [View] ⇒ [Bar Monitor] 若しくは、ツールバー     をクリックすると、バーモニターウィンドウを最前面表示します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
各バーモニターの下部はアラーム（上段、ON 状態は黄色）とエラー（下段、ON 状態は赤）を表示します。 

   
 

  右からアラーム 1、2、3、4、5（アラームの詳細は「4.5 アラームとエラー」を参照下さい。） 

  右からエラー1、2、3、4、5、6（アラームの詳細は「4.5 アラームとエラー」を参照下さい。） 

 
 
メニューバー [View] ⇒ [Digital Monitor] 若しくは、ツールバー     をクリックすると、デジタルモニターウィンドウを最前面表示します。 
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6.6. SA-570 Naviバージョン情報確認 

 
メニューバー [Help] ⇒ [About SA-570 Navi] をクリックすると、SA-570 Navi のバージョン情報を表示します。 

 

 
 
 
 
 
 

6.7. ファームアップデート 

 
メニューバー [Help] ⇒ [Firm Update] をクリックすると、SA-570ST 本体ファームウェアバージョンアップを行います。 

 

まず、各 SA-570ST の現バージョンが表示されますので、バージョンアップを行う必要がある場合には、［はい(Y)］をクリック後、ファームウェアファイルを選択しま

す。 

 
 
 
 
 
 
 
 
 
 
 

［はい(Y)］をクリックするとファイル選択ダイアログが表示されますので、弊社ホームページよりダウンロードしたファームウェアファイル（拡張子名：tbf）を選択し、

[開く(O)]をクリックします。 

ファームウェアアップデートが開始され SA-570ST 本体のモニタ表示は、[UPdAtE]が点灯表示し、設定表示は、 [tranS]⇒[SEt]の順に点滅表示します。 

ファームウェアアップデートが完了すると[End]が点灯表示します。 

最後に SA-570ST 本体の電源を入れ直します。 

 

ファームウェアアップデートは、USBケーブルを接続している SA-570STのみが対象です。複数台の SA-570STを連結している場合は、個々に USBケーブ

ルを接続してファームウェアアップデートを行ってください。 

 

注意 

・SA-570ST を複数台（最大８台）連結して LINK 接続する場合、USB 接続できる PC は１台です。 

・ファームウェアアップデート中は、絶対に SA-570ST の電源を OFF にしたり、USB ケーブルを抜かないで下さい。 

 

6.8. 設定のファイル書き出し 

 
メニューバー [File] ⇒ [Save Parameter] をクリックすると、現在の各 SA-570ST 本体の設定をファイルに保存します。 

 

注意：設定のファイル書き出しでは、[Monitor In/Out]、[Monitor Peak/Mean]、[CAL ON/OFF]、[CAL RANGE]及び[Panel Lock]の設定値が全て

の SA-570STの共通値として設定ファイルに書き込まれます。 
 

6.9. 設定のファイル読み出し 

 
メニューバー [File] ⇒ [Load Parameter] をクリックすると、予め保存した設定ファイルを読み出して、各 SA-570ST 本体に設定を行います。 

 

注意：該当するアンプ IDの SA-570ST が接続されていない場合は、そのアンプへの設定は無視されます。 

 
 

MEMO: 
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第 7章 仕様 

 

7.1. ストレインアンプモード仕様 

 

1)最大入力 ：±20000×10－６ひずみ（B.V: 10V、GF: 2.0 の時） 

2)最大感度 ：100×10－６ひずみにて 0.5Ｖ出力（B.V: 2V、GF: 2.0 の時） 

3)適応ゲージ抵抗   ：60～1500Ω 

4)ゲージ率              ：2.00 固定  

5)感度設定 

 精度      ：±0.3%/F.S 

 マニュアル設定 ：ひずみ量値を任意の電圧（最大 10V）に設定できます。 

 但し、最大感度、最大入力値の範囲 

 ＴＥＤＳ設定 ：IEEE 1451.4 クラス 2 インターフェース、Template (ID=33)に対応 

TEDS メモリの定格出力データ値を読み、任意の出力電圧（1、2、5、10V）に自動で感度を設定。また、

TEDS センサのデータから最適ブリッジ電圧に自動設定。 

但し、出力電圧の設定は最大感度、最大入力の範囲。 

NDIS 規格コネクタの F、G ピンを TEDS メモリデータピンに当てているため 

ブリッジ電源のリモートセンス機能との併用はできません。 

6)安定度 零点 ：±1×10-6ひずみ/℃以内 但し、B.V 2V にて 

 感度 ：±0.01%F.S/℃  

7)S/N比  ：46dB (但し、最大感度 B.V 2.0V、L.P.F 10kHz にて) 

                38dB (但し、最大感度 B.V 2.0V、L.P.F PASS にて) 

8)オートバランス 調整範囲 ：±10000×10-6ひずみ 

  バランス精度 ：±0.1%/F.S 以内  但し、100×10-6ひずみ 0.5V 出力設定時 

 

7.2. DCアンプモード仕様 

 

1)最大入力       ：±100mV 

2)最大感度        ：0.1mV 入力にて 0.5Ｖ出力 （5000 倍） 

3)入力抵抗                 ：10MΩ以上 

4）感度設定 設定範囲 ：最大入力電圧の範囲で任意の電圧（最大 10V）に設定できます 

但し、最大感度の範囲 

 精度 ：±0.3%/F.S 

5)安定度 零点 ：±1μV/℃以内 （入力換算） 

 感度 ：±0.01%F.S/℃ 

6)S/N 比  ：46dB (但し、最大感度、L.P.F 10kHz にて) 

38dB (但し、最大感度、L.P.F PASS にて) 

7)オートバランス 調整範囲 ：約±30mV （入力換算電圧値） 

 バランス精度 ：±0.1%/F.S 以内 

 

7.3. 共通仕様 

 

1)測定点数  ：１台１点（多チャネル化可能） 

2)CAL 機能  ：設定感度に対して±50%、±100% 

但し、ストレインアンプモードで設定感度が 10000μST を超える場合は±50%のみ 

 精度 ：±0.3 %/F.S 以内 入力信号に重畳  

3)ブリッジ電圧  ：1、2、5、10Ｖ DC 、精度：±0．5％ 、最大電流：約 30mA 

リモートセンシング ON/OFF 機能付き 

4)出力電圧設定  ：無効、1、2、5、10V  

5)出力電圧微調  ：1～約 1/3 まで連続可変 

6)出力シフト機能  ：0～±出力電圧レンジまで(各レンジ 10％ステップ） 

7)応答周波数範囲  ：DC～150ｋHz（+0.5/-3dB） 但し、L.P.F/H.P.F ： PASS 時 

8)同相成分除去比  ：80dB 以上 （DC～60Hz） 

9)最大出力電圧  ：±10Ｖ/10mA、 負荷抵抗、 1ｋΩ以上 

10)非直線性  ：±0.01 %F.S 

１1) ローパスフィルタ  ：10～99Ｈｚ、100～990Ｈｚ、1.0～9.9ｋＨｚ、10ｋＨｚ、及び PASS 

    （上位 2 桁設定可） 

  減衰特性  -12dB±1dB/oct バターワース特性 

  遮断周波数 -3dB±1dB 周波数のずれ±10% 

12) ハイパスフィルタ   ：1～9Ｈｚ、10～99Ｈｚ、100～990Ｈｚ、1.0～9.9ｋＨｚ、及び PASS 

(上位 2 桁設定可) 

1.0kHz 以上では出力電圧が最大 1.5dB 減衰します。 

減衰特性  -12dB±1dB/oct バターワース特性 

遮断周波数 -3dB±1dB 周波数のずれ±10% 
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電源  回路

ブリッジ電圧選択
 
　　　回路

　操作部
スイッチ/LED

F

A

B

E

C

G

D

 ローパスフィルタ
　　
　　　回路

CPU

外部ｺﾝﾄﾛｰﾙ入力
　　　コネクタ

出力バッファー
　
　　回路

　TEDS
レシ－バ

USB

A

B

C

D

SPI-H

F-ROM

COM

S-RDRAM

ゼロバランス/CAL
 
　　　回路

IRQ5

 SPI-H

ブリッジ電源 回路

SPI-L

NMI
ADD/DATA

リンク コネクタ

PORT CCOM

基準電圧

出力リレー

－5V

出力シフト回路

入力差動増幅
　　　
　　 回路

感度調整 回路

DC 9～30V

 SPI-H

 ハイパスフィルタ
　　
　　　回路

　 出力

10V/30mA

I/O

USB
コネクタ

＋8V

SPI-H

－8V

＋3.3V

＋5V

感度切 替回路

D

SPI-H

PORT A

F-RAM

B

B.V ERR
検出回路

C

A

A/D変換 回路

G

F

E

LOW VOLT
　検出回路

13) 表示（表示器）    ：6 桁 7 セグメントＬＥＤ 

 表示 ：出力電圧、入力ひずみ（電圧値） 値、符号表示など 

 設定表示内容 ：設定値 （感度、出力電圧、B.V、フィルタ） など 

13 ポイントレベルメータ 

１4）フロントパネル操作 ：PEAK/MEAN 切替スイッチ（DSP MODE） 

表示値 IN/OUT 切替スイッチ（MONITOR（LINK）） 

BALANCE 実行スイッチ 

機能 ON/OFF スイッチ 

左右上下カーソルスイッチ、ENTER スイッチ 

15）複数台接続  ：最大 8 台まで接続可能 

連結時は、別売オプションの連結用取付金具が必要です 

16) 電源  ：9～30VDC  約 0.7A（12VDC 時） 

  ※低電圧アラーム表示付き（約 8.0～8.5V 以下） 

  付属 AC アダプタ（入力：100-240VAC、出力：12VDC）   

 

17) 使用環境 

温度  ：0℃～40℃ 

湿度       ：20～85%RH（非結露） 

18) 外形寸法            ：49.5(W)×138(H)×240 (D) mm 

（専用スタンドと突起物含まず） 

19) 質量                  ：約 1Kg 

 

 

7.4. ブロック図 
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SA-570ST  周波数特性

（RANGE:2000×10
-6
st/B.V:2V/OUT:20Vp-p/L.P.F,L.P.F:PASS）
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7.5. 周波数特性、ローパスフィルタ特性、ハイパスフィルタ特性 

 

周波数特性 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ローパスフィルタ特性 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ハイパスフィルタ特性 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

 



 

Page 38 

 

7.6. 外観図 

 

 

 

 

 
 

 

 

おことわり 
仕様および外観は予告なく変更する場合があります。 

最新の仕様につきましては当社までお問い合わせ下さい。 
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お客様の個人情報の取扱いについて  
当社は、上記に基づき登録を頂いたお客様の個人情報について、当社の個人情報保護方針に基づき、下記の要領で取扱いをさせていただきます。  

1. 個人情報管理者  

お客様の個人情報については、下記の者を個人情報管理者として置き、適切なセキュリティを確保し、安全に保管いたします。  

  

2. 個人情報の収集および利用目的  

登録いただいたお客様の個人情報は以下の目的のために利用する場合があります。  

(1) 保証期間内のサービス活動およびその後の安全点検活動のため。 

(2) 今後の商品開発の参考とするため。  

(3) 商品の発送を行なうため。  

(4) 関連するアフターサポートを提供するため（ソフトウェア等のバージョンアップ情報のご提供を含みます）。  

(5) 新商品・サービスに関する情報を提供するため。  

(6) 展示会に関する情報を提供するため。  

(7) ご利用者の属性（住所など）ごとに分類された統計的資料を作成するため。  

3. 個人情報の第三者への提供  

登録いただいたお客様の個人情報は、次のいずれかに該当する場合を除き、いかなる第三者にも開示・提供いたしません。  

(1) ご利用者にサービスを提供する上で必要となる業務委託先に開示する場合。  

(2) 前項に定める利用目的のために、ティアックグループ会社に開示する場合。  

(3) ご利用者が事前に承諾された場合。  

(4) 法令により開示が要求される場合。  

(5) ティアック、ご利用者または、第三者の権利または財産を保護するために開示する必要がある場合。  

4. 個人情報の開示を求める権利および開示の結果、当該個人情報が誤っている場合に訂正または削除を要求する権利の存在ならびに当該権利を行使するための

具体的方法  

登録いただいたお客様個人の登録内容の確認を求められる場合、または、個人情報の内容の訂正、削除を求められる場合は、下記までご連絡下さい。  
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お問い合わせ先 
受付時間 月～金曜日（祝祭日及び弊社休業日は除く） 9:30～12:00 / 13:00～17:00 

 

ティアック株式会社  

〒206-8530 東京都多摩市落合 1-47 
本社・情報機器事業部 メジャメントプロダクト部 営業課 

TEL 042-356-9161 

FAX 042-356-9185 

大阪営業所 
〒541-0041 大阪府大阪市中央区北浜 2-2-22 北浜中央ビル B1F 

TEL 06-4706-3905 
FAX 06-6231-3082 

名古屋営業所 
〒465-0093 愛知県名古屋市名東区一社 1-79 第 6 名昭ビル 6F 

TEL 052-856-7355 

FAX 052-856-7366 

 

技術的なお問い合わせ 
受付時間 月～金曜日（祝祭日及び弊社休業日は除く） 9:30～12:00 / 13:00～17:00 

 
本社・情報機器事業部 メジャメントプロダクト部 営業課 

TEL 042-356-9161 

FAX 042-356-9185 

 

ホームページアドレス http://loadcell.jp/ 

 

 

故障・修理や保守についてのお問い合わせ 
受付時間 月～金曜日（祝祭日及び弊社休業日は除く） 9:30～17:00 

 
ティアック修理センター情報サービス部 

〒358-0026 埼玉県入間市小谷田 858 

TEL 04-2901-1038 

FAX 04-2901-1042 

 

 

住所や電話番号は、予告なく変更する場合があります。あらかじめご了承ください。

http://loadcell.jp/
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